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Introduction 

Semiconductor processing equipment requires precision performance of many 
components to meet the demanding challenges of integrated circuit fabrication.  Yet 
many tools are not capable of monitoring these components with enough detail to detect 
malfunctions.  For example, a process drift on a Chemical Vapor Deposition (CVD) tool 
may cause a gas phase particle nucleation problem, which will go undetected until 
product wafers fail to yield at final test.  When this happens, an effort to identify the root 
cause of the problem will require a detailed investigation of almost every process step.   

DataWindows was developed by Empirical Systems to detect component malfunctions 
and process variations on process equipment before product damage occurs.  This 
system integrates High Performance Data Acquisition hardware with an application 
that offers Advanced Analysis, Remote Data Review Software, and Integrated 
Statistical Process Control (SPC).  

High Performance Data Acquisition DataWindows can monitor up to 32 channels at 
up to 10,000 samples/sec/channel.  This enables a detailed image of system 
performance to be recorded.   

Advanced Analysis DataWindows can perform standard calculations such as mean, 
standard deviation, maximum, and minimum.  For dynamic data channels such as 
digital switches, valves, mass flow controllers, and robotic sensors, timers can be 
configured with independent start and stop events.  This permits timers to begin with an 
event on one channel and end with an event on another channel.  In addition, 
DataWindows can calculate Mass Flow Controller (MFC) overshoot, undershoot, 
stability time, and decay time for up to 16 steps/process cycle/MFC.  Remote Data 
Review Software DataWindows Remote software not only permits offline analysis, but 
also enables comparisons to be made between systems for process matching.   

Integrated Statistical Process Control (SPC) DataWindows can process SPC charts 
on demand or as the data is collected if the Realtime Analysis option is 
selected.  DataWindows can also provide links to corrective action decision trees, 
provide custom popup messages, and review out of control conditions with Pareto 
charts or a chronological listing.   

This document contains the information that is needed to setup DataWindows, collect 
data, review data, and perform analysis on the collected data.  The information that is 
contained in this documents, can also be accessed from help command buttons and 
menu bars that are embedded in the DataWindows application.  To obtain a 
DataWindows system or accessories, check Empirical Systems’ web site at 
www.empirical-systems.com.  

http://www.empirical-systems.com/
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Section 1) Setup 

The steps which are necessary to install, configure, and physically connect 
DataWindows to the process tool are described in this section.  After the user becomes 
familiar with these steps, he can proceed to the next section to learn how to collect 
data.   

1.1  Software Installation 
1.2  MX32USB Hardware Setup 
1.3  Signal Connections 
1.4  Data Collection Trigger Setup 
1.5  Data Collection Options  

1.1  Software Installation 

The software that is needed for data acquisition is an application which is available for 
Windows 2000, XP and Vista.  If you have purchased a laptop computer with your 
MX32USB, this software is pre-installed.  However if you purchased a MX32USB 
without a laptop or are upgrading software versions, the following steps can be followed 
to install the DataWindows software.  

1)  Obtain the latest version of DataWindows software from www.empirical-
systems.com 
2)  Unzip the files. 
3)  Execute the extracted SETUP.EXE file.  

After installation, you can select DataWindows from the Windows Start button.  

1.2  MX32USB Hardware Setup 

The MX32USB connects to laptops and desktop PCs via a USB 2.0 Cable.  While 
powered by the USB bus, the MX32USB can collect +/- 10V data on 32 analog input 
channels and can supply 5VDC to each of the 32, 9 pin connectors.  This 5VDC is short 
circuit protected at 25 mA at each connector, however the combined current draw from 
each of the 32 connectors for 5VDC output should be maintained below 50 mA while 
bus powered.  Exceeding this limit while bus powered may cause the PC or laptop to 
shut down the USB port.  If this occurs, remove the excessive current draw and remove 
and re-install the USB cable.  

For greater current draw, an external DC power supply can be connected to the 
MX32USB 5 pin circular DIN connector.  Recommended DC power supplies are listed 
below.  These power supplies have been tested with Rev A, B and C.  If an external 
power supply is used, 5VDC current should be limited to 80 mA for each of the 4 groups 
of 8 connectors (A1-A8 total current < 80 mA, A9-A16 total current < 80 mA, A17-A24 
total current < 80 mA, A25-A32 total current < 80 mA).  The external power supply also 
supplies +/-12VDC to each of the 32 connectors.  For +/- 12VDC, use the current limits 

http://www.empirical-systems.com/support.htm
http://www.empirical-systems.com/support.htm


4 

 

listed for the power supplies.  When calculating current draw, please note the 
MX32USB has internal 100 ohm resistance on each of the +/- 12VDC busses.  

Power Supply Brand +12VDC current -12VDC current 

Mean Well P25A13D-R1B   0.80 A 0.30 A 

ELPAC Power Systems WRI2731   0.38 A 0.38 A 

Table 1) Recommended DC power supplies.  

1.3  Signal Connections 

Once the DataWindows software has been installed and the breakout board has been 
connected, DataWindows software can be configured by following the instructions which 
are in this section.  

1.3.1  Reading and Saving Process Configurations  

Processes can be loaded, edited, and saved.  To load a process, select Read Process 
from the File menu.  The available processes will be displayed, and you will be asked to 
select the process to load.  Once loaded, the process can be edited by selecting items 
from the Configure menu.   From the Read Process panel, you will be restricted to the 
DataWindows\setup directory.  If you have been provided with a configuration file 
(*.DataWin), you must import it to DataWindows before it can be accessed by 
DataWindows (please see import section below).  

If you would like to make changes to the setup file select Save As... from the File 
menu.  The ability to save and load process information enables DataWindows to switch 
between different configurations when different sensor information is required or when 
moved to other process tools or applications.  

1.3.2  Importing and Exporting Process Configurations  

If you have been given a configuration file (*.DataWin file type) or if you are copying a 
configuration file from one computer to another, you will need to Import it before 
DataWindows will recognize it.  This is done by selecting Import Setup... from the File 
menu.  If the file is on another drive such as a diskette or flash drive, you can change 
the drive from the Look In: pull down control.  Once imported, a copy will be made in the 
Setup folder so that it can be accessed easier.  

To export a configuration file, select Export Setup... from the file menu.  

1.3.3  Channel Configuration  

The MX32USB has 32 differential analog input channels. Each analog inut channel has 
its own DB9F connector identified as A1-A32.  In addition to analog input, these 
connectors also provide the functions listed in Table 2.  
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Pin Number  Primary Function  Alternate Function  

1  Plus 5V  Digital Out 0  

2  Ext Minus 12V*  -  

3  Ext Plus 12V*  -  

4  Digital Out 1  -  

5  Analog In Signal  -  

6  Digital Out 2  -  

7  Analog In Return  -  

8  Digital Ground  -  

9  Digital Out 3  Digital In 0  

Table 2) DB9F pin signal descriptions.  *Only if external power supply is connected.  

Users can route analog signals to the DB9F connector with custom cables or a number 
of off the shelf interface cables are available.  After signals are physically connected to 
the MX32USB, the following instructions can be followed to configure the DataWindows 
software.  

To display the Channel Configuration Panel, select Channel Setup from the 
Configuration menu.  From this panel, the name, color, and status of each channel can 
be edited.  Also, this panel can be used to display channel connection information.  If 
you have been provided with a configuration file (*.DataWin) you can right click on on 
the channel name.  These instructions will provide you with the means to connect your 
signals even if you known very little about your system.  They encapsulate the expert 
knowledge of the author of the configuration file.  

These instructions can be modified by typing in the text box.  When you are finished 
with the connection popup panel, you can click on OK to return to the Channel 
Configuration Page.  If you made changes to the instructions, you will be asked if you 
would like to save them.  

To edit a channel name, left click on the channel name with the mouse and use the 
keyboard to edit the text.  To change the channel color, hold down the left button of the 
mouse while the cursor is over the colored box to the right of the channel name and 
select a new color from the color matrix.  To toggle the channel ON/OFF status click on 
the status button to the right of the color control.  

1.3.4  Linear Transformation  

A linear transformation can be performed on each channel to convert the voltage 
signals to convenient units. The Channel Configuration Page can be displayed by 
selecting Channel Setup from the Configuration menu.  On this page, the transformation 
slope can be entered into the field which is labeled with an A, while the transformation 



6 

 

offset can be entered in the field which is labeled with a B for each channel. If no 
transformation is desired, enter 1 in the A field and 0 in the B field.  

1.3.5  Data Types  

For some signals, it is often useful to perform calculations to obtain values for the mean, 
standard deviation, maximum, and minimum.  However, for channels that turn off and 
on, it does not make sense to calculate these values.  For example, it may be useful to 
know the mean deposition pressure or the mean signal from a MFC which is constantly 
flowing.  However, it may not be useful to know the mean valve state or the mean signal 
from a MFC since these signal toggle off and on.  Other channels are associated with 
signal conditioning accessories such as the MX-TC-K or the MX-TC-J which enable the 
user to connect thermocouples to the data collection system.  

For this reason, a parameter which is referred to as the channel Data Type is defined 
for each channel which enables the user to configure the type of calculation which is 
performed.  Below is a description of the Data Types that can be selected.  

Static When a channel Data Type is defined as Static , the mean, standard 
deviation, maximum, and minimum value can be calculated for each 
data set. 

Step When a channel Data Type is defined as Step, the step overshoot 
area, undershoot area, stability time, and decay constant can be 
calculated. 

Valve When a channel Data Type is defined as Valve, that channel will only 
be used for Timer Tests and Sigma Vector alignment (refer to the 
Data Analysis section of this document for more details on these 
tests). 

MX-TC-X When a thermocouple input is to be used, obtain a MX-TC-J or a MX-
TC-K from Empirical Systems and the Data Type should be set to 
MX-TC-J or MX-TC-K. 

To set Data Types for each channels, select Channel Setup from the Configure menu. 
Then, channel Data Types can be selected from the list box which is to the right of the 
channel color selection control.  If you are unsure of whether to choose a Static, Step, 
or Valve Data Type, just pick one; it can be changed later.  

When you have finished editing channel names, colors, status, Data Types, 
transformation parameters and connection instructions, click on OK to return to the Main 
Page.  If you would like to save the changes that you have made, select Save or Save 
As from the File menu.  Otherwise, select CANCEL to discard changes.  

  

http://www.empirical-systems.com/
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1.4  Data Collection Trigger Setup 

High speed data acquisition should capture critical process timing sequences, but not 
when the unit under test is idle. Triggered data collection allows DataWindows to collect 
high resolution data for extended periods of time without user intervention without 
consuming excessive disk space.  Triggers also make it easier to review data of 
interest.  

Some users are unwilling to use Data Collection Triggers because they are afraid to 
miss transition data at or before the trigger condition.  For this reason, DataWindows 
has been designed to collect data that includes between 1 and 2 seconds prior to a true 
trigger. This is accomplished by constantly saving data once the Start button has been 
pressed.  After one second of data has been collected, it will be saved regardless of 
whether a true condition is detected.  Then after the following second of data has been 
collected, triggers will be process to determine if a true state is detected.  If a true 
trigger is detected the data will be saved following the previous data.  If a true state is 
not detected, the file will be rewound and the newest data will be rewritten over the 
previous data.  Thus, a minimum of 1 second of data will be saved before a trigger 
condition occurs.  

Data Collection Triggers can be edited by selecting Trigger Setup from the Configure 
menu.  Two triggers are provided because one trigger is not always enough.  For 
example, you may want to collect data when Valve1 opens when Pressure1 is < 1000 
Torr, but not when when Pressure1 is > 1000 Torr.  This can be accomplished with the 
setup shown below.  

 

If you can specify data collection conditions with only one trigger, Trigger # 2 can be 
disabled.  Trigger # 2 can also be used to provide better alignment of data sets.  Good 
alignment of data sets makes it easier to review data sets with Overlay Charts and 
Sigma Vectors (refer to the data review and analysis sections of this document for more 
details).  

Both Data Collection Triggers can be turned off if you would like to test connections or 
simply collect strip chart data.  However, this method of collecting data will save all data 
in one data file that cannot be analyzed very easily.  

1.4.1  Trigger Type  

Triggers can be configured as Edge or Gate Triggers.  The difference is when the 
Trigger Delay timer will start counting.  With the Edge Trigger, the Trigger Delay will 
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begin when Trigger #1 and Trigger #2 (if it is activated) produce a logical state that 
transitions from false to a true state; while with the Gate Trigger, the Trigger Delay will 
begin when the triggers produce a logical state that transitions from a true to a false 
state.  Once the Data Collection Trigger(s) produce a true state, data collection will start 
and will continue until the Trigger Delay has expired.  The Trigger Type can be edited 
from the Trigger Setup Page.  

1.4.2  Minimum False Trigger Width 

To ignore brief false triggers following a true state, the Minimum False Trigger Width 
can be used.  It will prevent a new data file from forming unless the Minimum False 
Trigger Width is exceeded.  For example, if you are triggering on a valve that turns on 
for 5 seconds, turns off for 5 seconds, and turns back on again for 20 seconds during 
one process cycle, you can specify a Minimum False Trigger Width of 10 seconds to 
ignore the brief false state and prevent the process cycle counter from incrementing 
twice for each sequence.  

1.4.3  Trigger Delay  

The Trigger Delay parameter performs two functions.  First, it halts data collection after 
the process event has been triggered.  This prevents DataWindows from collecting data 
that has no interest and enables unattended operation. Note that each time a Data 
Collection Trigger occurs, the Trigger Delay timer will be reset to zero.  Second, it 
organizes data files into data sets.  Although each true Data Collection Trigger, which is 
separated by at least the Minimum False Trigger Width, will produce a new data file, 
these files will be grouped into sets if they occur before the Trigger Delay expires.  

For example, consider the following situation.  During a deposition run, 10 true Data 
Collection Triggers are produced which occur every 60 seconds.  If the Trigger Delay is 
set to 120 seconds, then data will be saved to 10 data files but, because the Trigger 
Delay never expired, these 10 files will be grouped into a data set which will be 
identified by a Trace ID which consists of a System ID prefix followed by a date and 
time stamp of the first trigger.  After the Trigger Delay expires, additional runs will 
produce a new data set.  

When a data set is formed, the user can chose to review or analyze the entire data set 
or he can chose to review or analyze individual elements of data sets.  It is a 
convenience that enables random access to the individual data files but still groups data 
by runs.  Furthermore, it enables comparisons to be made between elements of a data 
set to determine first wafer effects and other anomalies (refer to the Data Review and 
the Analysis sections in this document for more details).  

1.4.4  Precoat Timer  

Prior to processing, process tools often perform a precoat or an under coat to season 
the reactor.  It is useful to collect data during precoats as well as when wafers are 
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processed, however it is necessary to classify these events differently.  For this reason, 
a timer is defined which will discriminate between these two events (Trigger Delay and 
Minimum False Trigger Width are ignored for this calculation).  If the true time of the 
trigger exceeds the user specified Precoat Timer, the trace will be classified as a 
precoat rather than a standard deposition.  Because of the nature of edge triggers, this 
feature is not available when the edge trigger is selected.  

1.5  Data Collection Options 

The following data collection options can be configured.  

1.5.1  Sample Rate and Range  

The sample rate can be specified by selecting DAQ Setup from the Configuration 
menu.  The voltage range is fixed at +/- 10V with 610 micro volt resolution (16 bit).  

1.5.2  System ID  

A System ID can be specified by selecting System Name from the Configuration 
Menu.  This will identify all data which is collected for a particular unit with a System ID 
prefix.  This is particularly useful if you plan to collect data from multiple systems and 
would like to perform comparisons between systems.  

1.5.3  Realtime Analysis  

From the Tools menu, the Realtime Analysis option can be toggled.  When this option is 
turned on, data will be analyzed with the tests which are described in the Data Analysis 
section of this document as it is collected.  If you have not configured any of these tests 
this option should be turned off.  Also if CPU Usage bar graph (see the next section on 
Data Collection for a description) is approaching 100%, this option should be turned off.  
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Section 2)  Data Collection 

Triggered data collection enables continuous, unattended process monitoring and 
makes data review more convenient and efficient.  However, for those users that are 
accustom to other non triggered electronic strip chart software triggered data collection 
may seem to be complex and confusing at first.  If this is the case, the data collection 
triggers can be deactivated and DataWindows can be operated in manual mode.  

This section will describe the steps to configure DataWindows to collect data in manual 
mode without data collection triggers, and then it will go on to describe how to configure 
the data collection triggers to save only the process events that are of interest in 
separate data files.  Since the tests which are described in the Analysis section of this 
document only apply to data sets which have been collected with data collection 
triggers, it is recommended that the user learns to use the data collection triggers as 
soon as possible.  

Before attempting this section, the user should complete the Setup section of this 
document, all signal connections should be connected, and the channels of interest 
should be selected from the Channel Configuration Page.  

2.1  Manual Data Collection without Data Collection Triggers 
2.2  Automatic Data Collection with Data Collection Triggers 
2.3  CPU Usage 
2.4  Data Legend 
2.5  Toggling the Visibility of Channels 
2.6  Changing Strip Chart Parameters  

2.1  Manual Data Collection without Data Collection Triggers 

Manual mode is useful to verify channel connections and to study specific sequences 
that do not require the use of DataWindows Data Collection Triggers.  To collect data in 
manual mode, select Trigger Setup from the Configure menu. Then turn Data Collection 
Trigger #1 and #2 off.  Then click on OK.  

After the Data Collection Triggers have been turned off, Data Collection will begin as 
soon as the Start command button is clicked on.  Channel traces will be displayed on 
the strip chart in their own unique color (refer to the Channel Configuration Page section 
of the document for information regarding channel colors).  A new data set, with its own 
Trace ID, will be created each time the Start button is clicked on.  

In this mode, it is important to remember that data collection will continue until the Stop 
command button is clicked on.  If the system is left collecting data in this mode, it is 
possible that the data file will become so large that the hard drive will run out of 
space.  Furthermore, unless data is collected for short periods, this method will produce 
very large data files which will be very difficult to analyze.  
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2.2  Automatic Data Collection with Data Collection Triggers 

Triggered data collection can proceed after triggers are configured as described in 
Section 1.3.5.  After at least one Data Collection Trigger has been turned on, triggered 
data collection is started by clicking on the Start command button.  This immediately 
causes data to be saved every second.  However, if a Data Collection Trigger does not 
occur, the data will not be displayed on the strip chart and the data file will be rewound 
every second and old data will be written over.  When a Data Collection Trigger occurs, 
the new data will be appended to the end of the data file.  This will record the entire 
process event, including the data 1 to 2 seconds before the trigger condition(s) are met 
until the Trigger Delay expires.  

The Process Counter, which is displayed in a text box on the Strip Chart Page, will be 
incremented each time a new file is started within a data set.  When the Trigger Delay is 
exceeded, a new data set, with a new Trace ID, will be started and the Process Counter 
will be reset to 1.  The maximum Process Count is 999 cycles.  If 999 cycles are 
exceeded, a new data set will be created even if the Trigger Delay has not been 
exceeded and the Process Counter will be reset to 1.  

2.3  CPU Usage 

When data is collected, CPU Usage is displayed on a bar graph which is just above the 
strip chart graph.  The scale of this graph is 0% on the left to 100% on the right.  Since 
data is transferred from a buffer every second, it is necessary for CPU Usage to be less 
than 100%.  If the CPU cannot keep up with the data stream, the bar graph will turn red 
which indicates that data is being lost.  If this happens, the user should quit other 
applications, reduce the sample rate , reduce the number of monitored channels, or turn 
the Realtime Analysis option off (refer to the Setup section of this document for details).  

2.4  Data Legend 

A data legend is displayed on the right side of the screen when the strip chart is 
displayed.  It's width can be changed by selecting it's left edge with the mouse and 
dragging it to a new location.  You can hide or display the legend by toggling the check 
mark next to the Legend entry of the View menu or by pressing Ctrl L.  

2.5  Toggling the Visibility of Channels 

At times, it is difficult to view traces when they are displayed on the strip chart because 
the traces overlap.  Also, it is sometimes difficult to assign unique colors that make it 
obvious which trace corresponds to each channel.  For this reason, the visibility of 
channel traces can be toggled by selecting Display/Hide Traces from the strip chart 
View menu or by pressing Ctrl T.  This will display a list of active channels from which 
the user can select, with a check, the channels to display.  If new data is being 
collected, only the new data will be affected, however if old data is being reviewed, 
entire traces will be toggled.  
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2.6  Changing Strip Chart Parameters 

Select Change X-Y Scale from the View menu on the strip chart panel to edit the strip 
chart X and Y scales.  X and Y grid lines can be displayed or hidden by toggling the X 
Grid and Y Grid toggle buttons.  
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Section 3) Data Review 

After data has been collected, it can be reviewed by the methods that are described in 
this section.  Also described are methods to create PDFs from strip chart graphs and 
how to export data to text files which can be imported into external spreadsheets.  

3.1  Displaying the Data Review Panel 
3.2  Selecting Data to Review 
3.3  Selecting a Playback Destination 
3.4  Analyze Option 
3.5  Data Legend 
3.6  Toggling the Visibility of Channels 
3.7  Changing Strip Chart Parameters 
3.8  Creating Strip Chart PDF Files  

3.1  Displaying the Data Review Panel 

The Data Review Panel can be displayed by clicking on the Playback command 
button.  Once this panel is displayed, data can be selected for review, a playback 
destination can be selected, and the playback channels can be selected.  

3.2  Selecting Data to Review 

As explained in the Setup section of this document, data files will be grouped into data 
sets if they are collected before the Trigger Delay expires.  All files which are within a 
data set will have the same Trace ID.  All Trace ID’s will be displayed in the Trace ID 
listbox on the Data Review Panel.  A '+' symbol proceeding a Trace ID indicates multiple 
data files are within a Trace ID.  All process events within a data set can be selected by 
checking this entry in the Trace ID listbox.  

Alternatively, individual events within a data set can be selected by double clicking on 
the Trace ID entry.  This will change the '+' to a '-' and will list all available process 
events.  Then, the individual members of the data set can be checked.  

As each item is checked in the Trace ID listbox, process information is displayed in the 
text boxes to the right of the listbox.  The System ID, Process name, date, time, sample 
rate, the total number of process events, and the number of saved channels are 
displayed.  This information can be useful to select the correct data for review.  Each 
Trace also has a unique comment, up to 64 characters, which is displayed in the 
Comments textbox.  To save a new comment, edit the text in the Comment textbox, and 
then click on the Save New Comment command button.  

3.3  Selecting a Playback Destination 

From the Playback Destination listbox on the Data Review Panel, the user can select 
the destination of the recorded data.  A description of the various options follows.  
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3.3.1  Strip Chart  

When data is played to the Strip Chart destination, data will appear in the same manner 
that it was recorded.  This means that data will be scrolled from right to left as it is read 
from disk.  If this option is selected, the user is presented with control buttons that 
resemble a DVD player.  Options available include play, rewind, skip forward, skip back 
and fast forward.  At any time the user can click on Stop to stop the replay.  This option 
is useful for reviewing a large number of data files without using a lot of system memory 
to display the data all at once.  

3.3.2 Strip Chart with Manual X Scale  

This option can be used to display all data within a time range that is specified by the 
user.  After replay, the user can select Change X-Y Scale from the View menu to 
change the displayed range.  Also, the user can zoom in by holding down the Ctrl key 
and left clicking or zoom out by holding down the Ctrl key and right clicking.  Additional 
features are available from a menu that is displayed when the left mouse button is 
clicked (without the Ctrl key).  

3.3.3 Strip Chart with Auto X Scale  

This option can be used to display data sequentially on one graph.  This may be a good 
way to get an overview of the process at a distance.  After data has been displayed with 
this option, the user can zoom in by holding down the Ctrl key and left clicking or zoom 
out by holding down the Ctrl key and right clicking.  Additional features are available 
from a menu that is displayed when the right mouse button is clicked (without the Ctrl 
key).  

The amount of memory required for this option is proportional to the number of selected 
channels, the sample rate, and number of data files, and the length of the data 
files.  Therefore, if a replay is taking too long it may be because too much memory is 
being consumed.  If this is the case, press Stop to stop the replay and select fewer files 
to display of use Manual X Scale.  

3.3.4 Strip Chart Overlay with Auto Scale  

This option will align all selected data by the Data Collection Triggers and graph it onto 
the strip chart.  This enables a visual comparison to be made between data files.  Also, 
the user can zoom in by holding down the Ctrl key and left clicking or zoom out by 
holding down the Ctrl key and right clicking.  Additional features are available from a 
menu that is displayed when the left mouse button is clicked (without the Ctrl key).  

If it takes a long time to complete the replay with this method, it is probably due to a lack 
of memory.  If this is the case, press Stop to stop the replay and select fewer files to 
display or use Manual X Scale.  
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3.3.6 Text File  

If the Text File (traces only) option is chosen, the user will be prompted for a text 
filename to export the strip chart data to.  This will export data to a tab delimited data file 
that can be imported into a spreadsheet.  For this option a time column is not 
generated.  If you would like to export the time column, select the Text File (time and 
traces) option.  

3.4  Analyze Option 

If the user has configured any of the DataWindows analytical tests, such as Static 
Tests, Step Tests, Timer Tests, or Sigma Vector Tests, the Playback Option can be 
used to analyze the data as it is replayed.  To do this, select Analysis Data from the 
Analyze Option list box on the Data Review Panel.  After playback and analysis are 
complete, the results from the analysis can be reviewed with SPC Charts.  

3.5  Data Legend 

A data legend is displayed on the right side of the screen when the strip chart is 
displayed.  It's width can be changed by selecting it's left edge with the mouse and 
dragging it to a new location.  You can hide or display the legend by toggling the check 
mark next to the Legend entry of the View menu or by pressing Ctrl L.  

3.6  Toggling the Visibility of Channels 

At times, it is difficult to view traces when they are displayed on the strip chart because 
the traces overlap.  Also, it is sometimes difficult to assign unique colors that make it 
obvious which trace corresponds to each channel.  For these reasons, the visibility of 
channel traces can be toggled by selecting Display/Hide Traces from the strip chart 
View menu or by pressing Ctrl T.  This will display a list of active channels from which 
the user can select the channels to display.  If new data is being collected, only the new 
data will be affected, however if old data is being reviewed, entire traces will be toggled.  

3.7  Changing Strip Chart Parameters 

Select Change X-Y Scale from the View menu on the strip chart panel to edit the strip 
chart X and Y scales.  X and Y grid lines can be displayed by toggling the X Grid and Y 
Grid toggle buttons.  

3.8  Creating Strip Chart PDF Files 

After data has been graphed, a click on the Print to PDF command button will prompt 
the user for a PDF file name.  To view the PDF file, Adobe Reader is required.  Adobe 
Reader can be downloaded from www.adobe.com.  
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Section 4) Data Analysis 

First it is shown how a Process of Record can be chosen, then its is shown how 
analytical tests can be configured.  Following this, instructions are given to analyze 
triggered data sets which were collected by the methods that were described in the 
previous sections.  Then, a method of reviewing test results through SPC Charts is 
described and instructions are given to compare data sets with statistical tests.  

If the user has decided to collect data in manual mode without any data collection 
triggers, all data will be saved in one large data file that can not be analyzed very 
easily.  Furthermore, the tests that are described in this section, except for Static Tests, 
cannot be performed on data sets that have been collected in this manner.  Triggered 
Data Collection also enables the user to compare data sets with Overlay Charts and 
permits each deposition cycle to be analyzed.  For these reasons, the user is 
encouraged to use Triggered Data Collection whenever possible.  

4.1  Process of Record Selection 
4.2  Configuring Analytical Tests 
4.3  Data Analysis 
4.4  Reviewing Results with Statistical Process Control (SPC) Charts 
4.5  Activated SPC Charts 
4.6  Alarm Review 
4.7  Data Comparisons  

4.1  Process of Record Selection 

Before Timers can be configured and before Sigma Vectors can be calculated, it is 
necessary to select a Process of Record.  From the File menu, select Choose the 
PROCESS OF RECORD from....  This will display all available data from which you can 
make a selection.  The purpose of this selection is to indicate a typical run which is 
representative of how the data should look.  Once this is accomplished, you can 
proceed to the next sections of this document to learn how to setup Timers and Sigma 
Vectors.  

DataWindows has the ability to save and load different configurations, also known and 
processes, for each process application.  When a new process is created by selecting 
the Save Process As... entry from the File menu, a copy of the current Process of 
Record is made if it exists.  When new data has been collected with the new process 
configuration, a new Process of Record should be selected from the new data if 
significant changes have been made to the configuration.  Each process should have its 
own Process of Record which is representative of that process.  

4.2  Configuring Analytical Tests 

This section instructs the user on the methods to configure the analytical tests which 
can be performed by DataWindows.  After the tests are configured, the next section of 



17 

 

this document will describe the methods which will perform the analysis with the 
configuration which is described within this section.  

4.2.1  Static Tests  

Calculations on each channel that has been assigned the Static will be performed to 
determine mean, standard deviation, maximum, and minimum each time a data set is 
analyzed.  No addition configuration is needed, after the Static Data Type has been 
selected.  Control limits for these channels can be edited by selecting Limits for Static 
Data Types from the Control Limits menu.  

4.2.2  Timer Tests  

Timer tests are configured by selecting Timer Setup from the Configuration menu.  The 
timer setup page will allow you to define up to 16 timers with independent start and stop 
events.  Follow these steps to set up a timer.  

1) Create a new timer by clicking on Add Timer button or select an existing timer from 
the Selected Timer listbox.  If prompted, enter a descriptive name for the timer. 

2) Specify a Start Event condition by choosing a start channel, a start inequality 
(greater than or less than), and a start value.  

As in ...  

 

Note that the linear transformation specified by the channel setup is performed prior 
to the comparison.  Also be aware that 100 mV hysteresis is added to the start 
channel if the start condition is true (prior to the linear transformation) to reduce 
chances that a noisy signal could cause multiple events. 

3) Specify an End Event condition in a similar fashion. 

4) Click on the APPLY command button.  This will display the start channel on the 
upper graph and the end channel on the lower graph.  Events will be marked with 
dots on the graphs. 

5) More than one Start Event may occur or more than one Stop Event may occur (refer 
to figure below).  If necessary select the desired Start Event by clicking on Previous 
Start Event or Next Start Event. 

6) Select an End Event by clicking on Previous End Event or Next End Event.  Note 
for the Process of Record, the timer result is displayed just above the 
Selected Timer. 

7) Repeat for each timer that you would like to turn on. 
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After this procedure has been followed to set up timers, timer calculations will be 
performed each time a data set is analyzed.  Once Timer Tests have been configured, 
Timer Test Control Limits can be edited by selecting Timer Limits from the Control 
Limits menu.  

 
Example Timer Setup  

4.2.3  Step Tests  

Calculations on channels which have been assigned the Step Data Type can be made 
to determine the step Overshoot Area, the Maximum Overshoot, the Undershoot Area, 
the Minimum Undershoot, the Stability Time, and the Decay Constant.  The definition of 
these parameters are described below.  Specification limits for these parameters can be 
edited, after step channels have been configured, by selecting Step Limits from the 
Control Limits menu.  
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Overshoot Area = Area under the channel trace which is above the target when the 
Step Trigger Channel is > 0.5 Volts. 

Maximum Value = 
Maximum value obtained when the Step Trigger Channel is > 0.5 
Volts. 

Undershoot Area = Area above the channel trace which is below the target when the 
Step Trigger Channel is > 0.5 Volts. 

Minimum Value = After the Maximum Value is obtained, the Minimum Value will be 
measured while the Step Trigger Channel is > 0.5 Volts. 

Stability Time = A timer is defined which starts when the Step Channel enters the 
region which is bound by the Setpoint Upper and Lower Control 
Limits.  If the Step Channel exits this region the counter is reset to 
zero.  The Stability Time is defined as the value of this timer when 
the Step Trigger Channel turns off (< 0.5 Volts). 

Decay Constant = The time that it takes the Step Channel to decay to 1/e of the 
target value after the Step Trigger Channel turns off (channel 
becomes < 0.5 Volts). 

To configure step tests, at least one input channel must be configured as a step channel 
(see Data Type selection).  Once this has been completed, Step Tests can be selected 
from the Configure menu.  Then follow these steps to setup each step channel.  

1) Select the step channel of interest from the Step Channel text box. 

2) Select the Step Trigger Channel from the Step Trigger Channel.  This channel is 
used to determine when the step begins and ends. For mass flow controllers 
(MFC’s) the MFC setpoint makes the best choice for the Step Trigger Channel. 

3) Specify the number of Steps per Trigger by editing the Steps/Trigger number. 
Steps/Trigger should be set to 1 if the step channel turns on only once during each 
trigger. If a step channel turns on, turns off, turns on, and turns off for each time a 
triggered event occurs, then the Steps/Trigger could be set to 2. 

4) Click on the Stability Test Limits command button and specify the Stability Lower 
Control Limit, Target, and Upper Control Limit for each step. If you do know what 
values to enter, enter a percentage of the setpoint channel. 

5) Repeat for each channel with the Step Data Type.  When you are finished setting up 
step channels, you can click on the Summary command button to verify step 
channel setup.  Then click on Ok to return to the data collection panel. 

 

4.2.4 Sigma Vector Tests  

Sigma Vectors are a form of pattern recognition which are useful for detecting a 
difference between the current data set and the recorded Process of Record. Sigma 
Vector tests are activated by setting the Sigma Vector control limits to non-zero values. 
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This can be accomplished by selecting Sigma Vector Limits from the Control Limits 
menu. Sigma Vectors are defined to be  

Sigmai = SUM[abs(yi
TEST - yi

POR)] / SUM[yi
POR]  

where 
 

 
yi

TEST = Test Trace Data 

and 
 

 
yi

POR = Process of Record Data 

and 
 

 
abs = absolute value 

and 
 

 
i = channel number 

and 
 

 
the summation is computed for all channel data points. 

As the summation is completed from the start of the trace to the end of the trace, the 
trace is aligned with the Process of Record Trace each time a channel with the Valve 
Data Type (see Data Type selection) makes a 5% transition of the data acquisition 
range.  

Since all channels with the Valve Data Type are used to align the data, it is important to 
carefully assign the Valve Data Type.  Typically, only those channels which can be 
identified to have a causal effect on another channel are assigned the Valve Data 
Type.  For example, MFC set signals, spindle up/down state, and valve signals can be 
assigned the Valve Data Type.  In some cases, it may be necessary to add addition 
channels specifically for alignment purposes in order to obtain meaningful Sigma 
Vectors.  

4.3 Data Analysis 

Once Timer, Step, Static, and Sigma Vector tests have been configured, the following 
methods can be used to calculate the results.  

4.3.1  Manual Data Analysis  

Previously recorded data sets can be analyzed by performing a playback with Analyze 
Data as the Analyze Option from the Data Review Panel.  This method will delete old 
results before creating new results and enables the user to re-analyze data sets after 
the configuration has changed.  If a new timer is configured, this method of analysis can 
be used to get the results from data sets which were recorded before the timer was 
defined.  
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4.3.2 Realtime Data Analysis  

Data sets can be analyzed as they are collected, if the Realtime Analysis option is 
activated from the Tools menu.  When using this option, CPU Usage should be 
monitored while data collection occurs.  If CPU Usage bar graph turns red, it indicates 
that data is being lost and that the computer cannot process data fast enough to keep 
up with the new data.  If this happens, the user should quit other applications, reduce 
the sample rate, reduce the number of monitored channels, or turn the Realtime 
Analysis option off.  

4.4 Reviewing Results with Statistical Process Control (SPC) Charts 

After data sets have been analyzed, SPC Charts can be used to review the results. This 
is done by selecting the desired chart from the SPC Chart menu.  After a chart has been 
selected, a panel will popup which will enable the user to specify the data which is 
included in the chart.  The Batch ID (also known as the Trace ID), the System ID, the 
Process, and the deposition number (also known as the wafer number) can be specified 
from this page.  If you are unsure of these parameters, just click on OK and use the 
default values.  

If a error message is displayed when you attempt to view a SPC Chart, it means that 
either your data selection parameters are too specific or that no data has been 
calculated for this chart.  If this happens, check the •gSelect All•h entry in each of the 
listboxes and try again.  If there is still no data available, it means that the test was not 
set up correctly or that data analysis has not be completed.  It may be necessary to go 
back and check the test setup to determine why no data is available and re-analyze the 
data to get a SPC Chart to display data.  

When a SPC chart is displayed, the most recent data points will be displayed on the 
right of the graph and the oldest points will be displayed on the left of the graph.  The 
mean and the mean + 3 sigma are displayed on this graph with green lines, while the 
user entered specification limits are displayed with red lines.  You can click on the 
Control Limits command button to display the mean and the mean + 3 sigma.  This will 
also enable you to select whether specification limits should be set to the natural limits 
(mean + 3 sigma) or to user entered specification limits.  

A histogram of the data points will be displayed to the right of the SPC Chart which 
should look like a Gaussian curve if the distribution of data is normal.  Defects, defined 
as those points which are beyond the specification limits, are calculated in parts per 
million and displayed above the SPC Chart.  Also displayed are values for Cp and Cpk. 
These parameters are defined below.  

Cp=(USL-LSL)/6*sigma  

Cpk=MINIMUM[(USL-mean)/3*sigma, (mean-LSL)/3*sigma]  
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where  

USL = Upper Specification Limit  

and  

LSL = Lower Specification Limit.  

You can use the mouse to click on any of the data points to display information specific 
to that data point in the text boxes which are below the chart.  If you would like to 
change the restrictions which were used to select the data in this chart, you can click on 
the Select Wafers command button which will redisplay the chart data selection 
panel.  You can also click on the Select Rules command button to display the SPC Rule 
Selection Panel and select the SPC rules to be used to detect out of control 
conditions.  When finished with the SPC Rule Selection Panel click on OK.  

If you would like to review strip chart traces from a particular SPC Chart data point, you 
can double click on the point of interest.  After confirming that you would like to display 
strip chart data, a panel will be displayed which enables you to select the channels to 
replay.  Then you will be given the option to create a new strip chart or add the data to 
the current strip chart.  

A click on the Print to PDF command button will send the SPC Chart to a PDF file.  

4.5 Activated SPC Charts 

After specification limits for a SPC chart have been chosen, the chart can be 
activated.  When the Realtime Analysis option has been selected from the Trigger 
Setup page, active charts will compare test results, as they are obtained, to 
specification limits.  Specification violations will be indicated by an alarm condition which 
will cause the DataWindows background color to turn yellow and a panel to popup 
which lists a description of each rule violation.  

SPC Charts can be activated by selecting Activate/Deactivate from the SPC Chart 
menu.  This will display a listbox which lists all available SPC Charts for each process 
which is selected from the listbox at the top of the page. Active charts are displayed in 
red text . Charts can be activated or deactivated by double clicking on the text 
entry.  SPC Charts can be viewed from this page by selecting a chart and clicking on 
the View Chart command button.  

4.6 Alarm Review 

When alarms are produced from a activated chart, they can be reviewed by selecting 
List from the Alarm menu.  If only one alarm has occurred, a panel will appear with a 
description of the active error.  If more than one error has occurred, a panel will appear 
with a List of the active errors.  The View Data command button on these panels will 
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display a SPC chart which includes the data that caused the alarm.  The alarm can be 
cleared by clicking on the Clear Error command button.  A click on the Disable 
command button will deactivate the SPC chart that produced the alarm.  

4.7 Data Comparisons 

After data has been collected, tests have been configured, and traces have been 
analyzed, DataWindows can perform statistical tests to determine if different test 
conditions produce a significant difference in the performance of the tool.  For example, 
data can be collected before and after a new software revision is loaded onto the 
process tool.  Then after the data is analyzed, statistical tests can be performed to 
determine whether the new software introduced any process changes.  This feature can 
also be used to diagnose process problems after a tool has produced defective wafers 
by comparing performance before and after the problem.  Furthermore, this feature can 
be used to compare the performance of one tool to another to determine if the tools are 
matched.  

To compare data sets, select Compare Batches from the tools menu. Then follow the 
steps which are listed below.  

4.7.1 Select Process of Record Batches  

Two groups must be defined to perform a comparison.  The group which is considered 
to be free of defects is called the Process of Record (do not confuse this with the 
Process of Record used to define Timers and Sigma Vectors).  This group is a 
collection of data sets which are selected based on Batch ID, System ID, Process, or 
Wafer Number.  Click on the Select Process of Record Batches command button and 
select the data which you would like to include in this group.  When finished, click on 
OK.  

4.7.2 Select Test Batches  

Test batches are selected in a similar way by clicking on the Select Test Batches 
command button.  However, test batches represent the data set that is suspected to be 
deviant.  

4.7.3 Select Confidence Level  

After Process of Record and Test Batches have been selected, click on the Select 
Confidence Level command button to select the confidence level for the comparison.  If 
you would like to highly confident of your results, select a high confidence level, 90% or 
higher.  If you would like to look for subtle differences, select a lower confidence level.  
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4.7.4 Select SPC Charts  

Then click on the Select SPC Charts/View Dual SPC Charts command button to select 
the SPC Charts that will be used to compare the batches.  A panel with a list of all of the 
available charts will be displayed.  Place a check next to the charts that you are 
interested in.  

4.7.5 View Dual SPC Charts  

Dual SPC Charts can be displayed by selecting the chart of interest from the list of 
available charts and clicking on the View Chart command button.  This will display the 
SPC Chart with the Process of Record data displayed in blue and the Test data in 
black.  A Dual SPC Chart is useful to visually observe the difference, if any, between the 
Process of Record batches and the test batches.  

4.7.6 Perform Comparison  

A Student T test can be performed between the selected data sets by selecting 
Compare Data Sets from the Tools menu.  This analytical test will estimate the 
difference between the Process of Record mean and the Test mean for each of the 
selected parameters.  This estimate will be a range that has a probability of containing 
the difference in means that is equal to the user selected confidence level.  If this range 
does not include zero, it can concluded that there is a statistically significant difference 
between the means and the comparison will not pass the test.  If this range does 
contain zero, it can be concluded that there is no statistically significant difference 
between the means and the comparison will pass the test.  

The Process of Record and Test mean and standard deviation will be listed for each 
parameter as well as the number of points that were used in the calculations.  If less 
than 25 points have been used to calculation, a warning will be generated.  If less than 
3 points are used in a calculation, the test will automatically fail, in which case the user 
should select more data.  
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